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How to Easily Perform Power Regression Analysis in Excel

Analyzing relationships between variables is a cornerstone of statistical and quantitative research.
While many phenomena follow a simple linear path, certain scientific and economic models--such
as those describing growth, decay, or diminishing returns--are fundamentally curvilinear. For these
situations, non-linear regression techniques are required. Specifically, power regression provides a

robust method for modeling relationships where one variable changes exponentially relative to
another.

This comprehensive guide details the precise, step-by-step process for performing power
regression using Microsoft Excel. Since Excel's native regression tool is designed for linear
models, we must first employ a critical mathematical transformation--linearization--to make the
power model solvable.

Understanding the Power Regression Model

The mathematical form of a power regression equation is distinct from standard linear models (y =
mx + ¢). It is defined by the following expression:

y = axb

In this equation, y represents the response variable (the output we are trying to predict), and x

represents the predictor variable (the input). The parameters a and b are the fixed, unknown

regression coefficients that define the nature of the relationship. Our primary goal in power

regression is to estimate the optimal values for these coefficients based on observed data.

The coefficient a acts as a scaling factor, while b dictates the curvature of the relationship. If b is
greater than 1, the curve accelerates (growth); if b is between 0 and 1, the curve decelerates
(diminishing returns); and if b is negative, the curve shows a rapid decline. Because the
relationship involves a variable raised to an unknown power, the model is inherently non-linear,
meaning traditional Least Squares fitting methods cannot be applied directly.

Linearizing the Power Regression Equation

To bypass the complexity of fitting a true non-linear regression model, we utilize a technique called

log-transformation. By applying the natural logarithm (In) to both sides of the power equation, we

successfully convert the multiplicative, exponential structure into a simple, additive linear form. This
allows us to use standard linear regression methods on the transformed data.

The transformation proceeds as follows:
Start with the power equation: y = axb

Apply the natural logarithm to both sides: In(y) = In(axb)
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Using log rules (log(A*B) = log(A) + log(B)): In(y) = In(a) + In(xb)
Using log rules (log(Ab) = b*log(A)): In(y) =In(a) + b * In(x)

The resulting equation, In(y) =In(a) + b * In(x), perfectly aligns with the linear regression structure:
Y* = A* + bX*. Here, Y* = In(y) is our transformed response variable, X* = In(x) is our transformed

predictor variable, A* = In(a) is the intercept, and b is the slope. Excel can easily estimate A* and

b, which are the parameters of the linear model. We will then reverse the log operation on A* to
retrieve the original coefficient a.

Prerequisites: Enabling the Data Analysis ToolPak

To perform the necessary regression analysis in Excel, you must have access to the advanced
statistical functions provided by the Data Analysis ToolPak. This add-in is not enabled by default in

most Excel installations, so verification is required before starting the analysis.

Navigate to the Data tab on the Excel ribbon. Look for the Data Analysis option within the
Analyze group, typically located on the far right. If this option is missing, you must manually load
the Data Analysis ToolPak through the Excel options menu (File > Options > Add-ins).

Once in the Add-ins menu, select 'Excel Add-ins' from the 'Manage' dropdown, click 'Go," and
check the box next to 'Analysis ToolPak.' Loading this add-in is fundamental, as it provides the
dedicated Regression function we will use in Step 3. Without it, performing the required statistical
calculations manually would be exceptionally time-consuming and prone to error.

Step 1. Preparing Your Dataset in Excel

The initial phase involves organizing and verifying your raw data. You should have two columns of
numerical data: one for the predictor variable (x) and one for the response variable (y). Ensure that
these columns are clearly labeled.

For a successful power regression, all values for both x and y must be strictly positive (greater
than zero). If your data includes zeros or negative values, the natural logarithm function used in the

next step will fail, as the logarithm of zero or a negative number is undefined in real number
mathematics. If such values exist, you may need to apply a small constant shift to all data points or
consider an alternative non-linear regression technique.

We begin by entering our raw data. The example below illustrates a typical arrangement of the
initial x and y columns:
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A B C D E F G

1 X '
2 1 1
3 2 8
4 3 5
5 4 7
6 5 6
7 6 20
8 7 15
9 8 19
10 9 23
11 10 37
12 11 33
13 12 38
14 13 49
15 14 50
16 15 56
17 16 52
18 17 70
19 18 89
20 19 97
21 20 115
22

23

24

25

)
bl

Having the data correctly structured in adjacent columns streamlines the subsequent data
transformation and selection process within the Data Analysis tool, minimizing the chance of input

errors during model fitting.

Step 2: Linearizing the Data using Natural Logarithms

This is the crucial data preparation step where we apply the natural logarithm transformation to
create the linear variables required by Excel. We will create two new columns: LN(x) and LN(y).

In the first available cell for the LN(x) column (e.g., cell C2, assuming raw data starts in row 2),
input the Excel formula: =LN(A2). This calculates the natural logarithm of the corresponding x-
value. In the adjacent cell for the LN(y) column (e.g., cell D2), input: =LN(B2). After entering these
formulas, drag them down to apply the transformation to every single data point in your dataset.

This transformation is mathematically powerful, converting the exponential relationship into a linear
one. The values generated in the LN(x) and LN(y) columns are the inputs we will use to estimate
the linear regression coefficients. This table shows the data following the transformation:
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A B C D E F G H

1 X | y In(x) In(y)
2 1 | 1 =IN(A2) | 0
3 2 8 0.69 2.08
4 3 5 1.10 1.61
5 4 7 1.39 1.95
6 5 6 1.61 1.79
7 6 20 1.79 3.00
8 7 15 1.95 2.71
9 8 19 2.08 2.94
10 9 23 2.20 3.14
11 10 37 2.30 3.61
12 11 33 2.40 3.50
13 12 38 2.48 3.64
14 13 49 2.56 3.89
15 14 50 2.64 3.91
16 15 56 2.71 4,03
17 16 52 2.77 3.95
18 17 70 2.83 4.25
19 18 89 2.89 4.49
20 19 97 2.94 457
21 20 115 3.00 474
22

23

24

25

Ensure that no errors (such as #NUM! errors, which would indicate negative or zero input) appear
in these new columns before moving to the analysis phase.

Step 3: Running the Linear Regression Analysis

Now that the data is linearized, we can proceed to fit the linear model using Excel's Regression
tool. This procedure treats LN(y) as the dependent variable and LN(x) as the independent variable.

Navigate to the Data tab and click the Data Analysis button. From the list of analysis tools, select
Regression and click OK. This opens the Regression dialog box, where you must define the input
ranges based on your transformed data.
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Formulas  Data  Review View  Help 1% Share 2 Comment:

U Al ﬂé Y = ) E7 & 'S Data Analysis
hy [= z Sort Filter T Data Forecast | Outline
raphy |5 Al
ﬁ Tools v v
Sort & Filter Analysis
D E F G H J K

Carefully set the parameters:

Input Y Range: Select the entire column containing your LN(y) values (Column D in the example).
Input X Range: Select the entire column containing your LN(x) values (Column C in the example).
Check the Labels box if you included the header row in your range selection.

Select an appropriate Output Range to display the results, typically on a new worksheet.

Upon clicking OK, Excel will instantly generate a comprehensive statistical report detailing the
fitted linear relationship between the transformed variables.
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D
In(x)

0.69
1.10
1.39
161
1.79
1.95
2.08
2.20
2.30
2.40
2.48
2.56
2.64
2.71
2.77
2.83
2.89
2.94
3.00

Step 4: Interpreting the Regression Output

E
In(y)

2.08
1.61
1.95
1.79
3.00
2.71
2.94
3.14
3.61
3.50
3.64
3.89
3.91
4.03
3.95
4.25
4.49
4.57
4.74

F G H J K
b
Regression ? X
Input
P
Input Y Range: $ES1:$E$21 1
Cancel
Input X Range: $D$1:$D$21 1
Hel
Labels |:| Constant is Zero
[] confidence Level: 95 %
Output options
@ Output Range: $G$1‘ 1
(O New Worksheet Ply:
O New Workbook
Residuals
|:| Residuals D Residual Plots
[] standardized Residuals [ Line Fit Plots

Normal Probability
|:| Normal Probability Plots

The regression output provides all the statistical evidence needed to confirm the model's viability

and extract the crucial coefficient estimates. Focus your interpretation on two main sections:

Summary Output and the Coefficient Table.

The Summary Output includes the R-squared value, which indicates how well the linear model fits

the transformed data. More importantly, the ANOVA table contains the F-statistic and the

Significance F (p-value). In the example, the F-statistic is 254.2367, and the corresponding p-value

is extremely small (4.61887e-12). Since this p-value is far below the standard alpha level of 0.05,

we conclude that the fitted model is statistically significant and provides a useful fit for the

relationship between In(x) and In(y).
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G H J K L M N (0]
SUMMARY OUTPUT

Regression Statistics
Multiple R 0.966375
R Square  0.933881
Adjusted R 0.930208
Standard E 0.318685

Observatio 20
ANOVA

df SS MS F Significance F
Regression 1 25.82038 25.82038 254.2367 4.61887E-12
Residual 18 1.828087 0.10156
Total 19 27.64847

Coefficientsandard Errc  t Stat P-value Lower 95% Upper 95% ower 95.0%pper 95.0%
Intercept  0.153334 0.203322 0.754143 0.460516 -0.273829448 0.580497 -0.27383 0.580497
In(x) 1.434391 0.08996 15.9448 4.62E-12 1.245392243 1.623389 1.245392 1.623389

The most important data is found in the Coefficients table. We need the values listed under
"Coefficients"” for the Intercept and the LN(x) variable. These represent the linear model: In(y) =
Intercept + b * In(x).

Intercept (In(a)): 0.15333
LN(x) Coefficient (b): 1.43439

Therefore, the fitted linear model is: In(y) = 0.15333 + 1.43439 * In(x).

Step 5: Deriving and Applying the Power Regression Equation

The final crucial step is the back-transformation, converting the linear model coefficients back into
the parameters of the original power equation: y = axb. The exponent b is directly estimated as the
coefficient of LN(x), so no transformation is needed for that parameter (b = 1.434309).

However, the Intercept found in the output is equal to In(a). To find the original coefficient a, we
must apply the exponential function (e, or EXP in Excel) to the Intercept:

a = elntercept

Using our example results: a = €0.15333. Calculating this value (using =EXP(0.15333) in Excel)
yields a = 1.1657. We now have both the original regression coefficients.
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Substituting these values back into the power equation structure, we obtain the final fitted model:
y = 1.1657x1.43439

This power regression equation is now fully derived and represents the best fit curve for the

original, non-linear dataset.

Step 6: Predicting Values Using the Fitted Model

The derived equation can now be used for practical prediction. This allows us to forecast the value
of the response variable y based on any given value of the predictor x, provided x is within a

reasonable range of the data used to fit the model.

For instance, if we wanted to predict y when the predictor variable x is equal to 12, we substitute
12 into the final equation:

y = 1.1657 * (12)1.43439
Performing the calculation:
y = 1.1657 * 35.316

y = 41.167

Based on the model derived from our dataset, the predicted value for y when x is 12 is 41.167.
This final step validates the entire process, demonstrating how the linearization and back-
transformation successfully yield a non-linear prediction model using standard Excel tools.

For high-volume calculations or verification purposes, specialized calculators or software can
streamline this process. These tools often handle the internal log-transformation and back-
transformation automatically.

Bonus: Feel free to use this online power regression calculator to automatically compute the

power regression equation for a given predictor and response variable.
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